
Overview 




eComm is an affordable eCommerce solution, designed to put your business online. With eComm, you can take orders 24 hours a day, 7 days a week, complete with secure order management and credit card processing. An intuitive interface combines ease of use with the kind of features you would expect from a professional package. You do not need to be an expert to use eComm. eComm has been specially designed to cater for eCommerce projects no matter how large or small. Inventory facilities include, product naming, coding, description, weights, freight costs and product categorization. Any updates to new products and services can be immediately implemented. eComm Store will work with any Internet service provider where web hosting is available, and can be easily incorporated into an existing website. 
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Features Overview 



· Accept orders 24 hours a day 7 days a week 

· Process Credit Card transactions online or manually. 

· Secure online transactions and order management. 

· Build a detailed product database - images, freight, descriptions and more. 

· Automatically generate an eCommerce website directly from your product database. 

· Simple, instant updates to the website pages from your product database. 

· Design your own web site, or choose from a range of pre-defined styles. 

· Can be incorporated into your existing website. Requires no programming skill or CGI access. 

· Works with any website host and Internet Service provider (ISP) 

· Integrated order management. 

· Invoice generation. 

· Online Order Processing through a range of third party processing agents. 

· Publish feature to upload store changes directly to the web server. 

· ON or OFF screen shopping cart to increase the product display area 

· Free Support 
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eComm Versions 




There are four versions of eComm, a Demo version, eComm Store, eComm PRO and eComm Developer. 

· eComm demo
The demo version allows you to build a store but does allow access to the secure order server, therefore you will be unable to take orders. 

· eComm Store
eComm Store allows you to build one store. There is a fee of US$15 for order server hosting. 

· eComm PRO
eComm PRO allows you to build a number of independent stores with the one program. There is no fee for order server hosting. 

· eComm Developer
eComm Developer allows you to build a number of independent stores with the one program. Seperate order management client for end users. Optional order server hosting fees. 
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Registering Your Program 




To register and upgrade your software, you will need to obtain registration details. To purchase a registration key from the Trellian web site, Select Register from the Help menu of eComm, and click on the "Obtain registration key" link. Alternatively you may purchase the software from an authorized Trellian software reseller. 

Once you have all of your details ready, follow these steps to register eComm. 

Step 1. - Select Register from the Help menu.
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Step 2. - Enter your registration details. Registration details are case sensitive. Your username will be the email address you registered with. If you have lost your registration details, click the relevant link on the registration window, and follow the instructions. Click the Next button to continue. If your registration details are accepted, a thank you message is displayed 
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Step 3. - eComm will then begin searching for any missing components that you may be entitled to download. It will then to ask you whether you would like to download these components. Click Yes to upgrade now, or you can upgrade the components at a later date. If you do not upgrade, the full program features may not be available 
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System Requirements 




Operating Systems:
Microsoft Windows 95/98/Me
Microsoft Windows NT/2000/XP

Internet Browsers:
Microsoft Internet Explorer 5.x/6.x
Netscape Navigator 5.x/6.x

CPU/Processors:
Intel Pentium I, II, III, IV, AMD or compatible

RAM/Memory:
16Mb or greater (64Mb recommended)
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Upgrading 




To keep eComm current, upgrades should be installed from time to time. These upgrades are free to all registered users.

To download the latest upgrade, select the Upgrade option from the File menu. LiveUpgrade will contact the upgrade server to check if there are any upgrades available. 
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All available components will be displayed in the selection list. All items that can be upgraded will be marked with a red clock icon. To upgrade these items, tick the checkbox next to the program and/or component name and click the Upgrade button. 

Items marked by a grey dot have not been installed.

Items marked with a green tick are current and no update is required.
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FREE Support 




FREE email support is offered to all registered users of eComm.

If you are experiencing problems, or are requiring answers to a technical question, please write us an email detailing the issue, or issues that you are experiencing and send it along with any other related information to our Support Department.

You may contact this department by sending an email to support@trellian.com.

Support Hours:
Open Mon - Fri, 9:00am - 5:00pm (Melbourne, Australia - Eastern Standard Time)
Please include your registration key, and some basic information about your computer and the Operating System you are running. Also, before emailing support, please check the FAQ first, as 90% of all questions we receive are already answered on these pages. You can view the FAQ by selecting FAQ from the Help menu. 
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Using eComm 




This chapter explains how to build a store. 
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Starting A New Project 




Each store you build will be created as a new project. eComm provides a wizard to help you configure your store. The wizard starts up automatically when creating your first store, and anytime you create a new store. 

You can navigate forward and back through the wizard using the Next and Back buttons at the bottom of the wizard. You can start the interactive help option at any time by pressing the Help button on each page of the wizard. 

To create a new project, select New Store from the File menu. 
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Enter a folder name for the project to be saved in. These characters , . / \\ ? or - may not be used in the project folder name. Click Next to continue. 
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Enter a name for your store. This title will be used at the top of each page in your store. You can change this title later. Click Next to continue. 
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Select a style and schema for your store. The layout selector allows you to choose a layout style from the left hand list and then select a layout schema from the right hand list. The Layout Style allows you to select the overall feel of the site, you can see a preview of the default styles on the right hand side as you select them. The schema for a given style generally changes the color and small layout items, but the style is similar. The style and schema can be changed later, however custom changes will be lost when changing to a new template. Click Next to continue. 
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Enter the contact details for your store.Click Next to continue.
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Select the credit cards your store will accept. These are automatically applied to your order page. To select a card that your store will accept, highlight the name of the card you wish to add on the left hand list of cards and click the ">>" button in to move the card to the list on the right. To remove a selected card from the list, simply highlight the card in the selected list on the right and click the "<<" button to remove the card. To add a card type that does not appear on the list, enter the name of the card in the "Other" box at the bottom of the wizard and click the ">>" button next to the "Other" field. Cards can be added and removed later. Click Next to continue. 
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Enter a message to be displayed at the bottom of the order from. If your bank requires company details on the order form, enter the details here. You may use HTML or just plain text. You may wish to include information about shipping times and other items related to ordering and order processing. Click Next to continue. 
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Enter a message to be displayed on the confirmation page after a customer has submitted an order. It is often useful to include things like how long their order will take to be processed, usual shipping times, contact information for your sales staff in case there is a problem with their order. Click Next to continue. 
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To publish your store on the Internet, the store will need to be hosted. To set up web hosting, click the Subscribe button and follow the prompts. If you already have web hosting, click the Next button to continue. 
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Enter shipping and freight details. eComm allows you to specify up to 3 shipping methods. You will be able to specify the countries and regions that you ship to in the next screen of the wizard. You can enter more specific details about shipping under the freight tab in the program itself. You can specify the calculations for the freight after finishing with this wizard. Click the Next button to continue.
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Select the countries that the store will ship to. Select a country by highlighting the country name on the left and clicking the ">>" button to move the country to the selected countries list. You can remove countries from your selection list by highlighting the country name on the right and clicking the "<<" button. You can use the "other" section of this wizard to add your own countries or regions. Click the Next button to continue.
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Specify how to calculate the freight for each order from the store.If you select "Set Price Per Order", the price in the .5 weight category will be the set price per order. If you select "Set Price per Item", then the value in the freight field on inventory tab will set the freight cost. Click the Next button to continue.
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Specify how to calculate tax on the order. If you select "Tax enabled shopping cart" the wizard will prompt you for tax information. For information and instructions for tax, see the Tax section of the manual. Click the Next button to continue.
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If you selected "No Tax" the setup wizard will finish. You can now enter product details. 
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Checking Settings 



Before continuing, check that the eComm settings are configured correctly for your store.

Proxy/Firewall Settings
If you are accessing the internet via a proxy server or firewall, first make sure that the proxy or firewall settings are entered correctly in Preferences. If you have a direct connection to the internet you can leave the proxy/firewall address blank, otherwise if the correct address is not specified eComm will not be able to connect to the Internet. Your ISP will inform you whether you need to access the Internet via a proxy. 

Browser Settings
You may need to set the path to your web browser to view web pages in eComm. Web browser settings can be changed in Preferences. 

Store Options
Now would be a good time to check the available options for the store. Store options can be changed in Preferences. 
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Adding a Product 




To add a new product, select the section of the store that you wish to add the product to from the store tree. Products can be moved into categories and shelves later if required. Then click the Product button. You can also use the New Product button on the toolbar, or right click and select New then Product from the popup menu. Enter a name for the product. 
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After creating a new Product, you can enter the product details on the Inventory tab. To preview the product in your web browser, click the Preview button. 

Assigning colors to the product
To enter a color for the product, click the >> button next to the color drop down box. Click the New button on the Color options window. 
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Enter a value for the new type that is added eg. Red. To rename a color, right click the color and select Rename from the popup menu. Repeat these steps to add more colors. 
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The color field can be changed for other uses eg. Materials. Enter "Materials" in the Color options window label field. Then click the New button and name the new type "Silk". 



Assigning sizes to the product
To enter a size for the product click the >> button next to the size drop down box. Click the New button on the Size options window. Enter a value for the new type that is added eg. Large, Small, 10-12 etc. Repeat these steps to add more sizes. 
The size field can also be changed for other uses eg. Materials. 


Image
If you want to include an image of the product, enter a filename or a URL to the image in the Image field. Click the << button to browse for an image file if you are unsure of the path and filename. If you are entering an URL, type the URL into the image field. Note: the 'http://' prefix must be included. 


Links to
This is the link opened when a customer clicks on the image of the product. Usually this will be a link to a larger picture of the product or category, however the link can also be to a web page. Enter a filename or URL in the Links To field, or click the << button to browse for an image file. 


For more information about the fields on the Inventory tab, see the Interface section of the manual. 
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Adding a Shelf 




A shelf allows you to place more than one product on the one page of the store. This is good for cross selling or listing related products on a single page. 

To create a new shelf, select the section of the store that you wish to add the shelf to from the store tree. Shelves can be moved into categories later if required. Then click the Shelf button. You can also use the New Shelf button on the toolbar, or right click and select New then Shelf from the popup menu. Enter a name for the shelf. 
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After creating a new shelf, you can enter the shelf details on the Inventory tab. To preview the shelf in your web browser, click the Preview button. For more information about the fields on the Inventory tab, see the Interface section of the manual. 

Moving products to the shelf
You can add existing products to a shelf by dragging the product on to the shelf in the store tree. The contents of the shelf will be displayed in the product pane. 
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Adding new products to the shelf
You can add products to the shelf by highlighting the Shelf in the Store Tree and adding new products to it with the toolbar or button bar. This option will not be enabled if a shelf cannot be added to the section of the Store Tree that you have highlighted. (You cannot add a shelf to a shelf or a shelf to a product.) The contents of the shelf will be displayed in the product pane. 
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Adding a Category 




A Category help you to break your store up into related components. You can create a category and then add other categories, products, shelves and lists below it. 

To create a new category, select the section of the store that you wish to add the category to from the store tree. Then click the Category button. You can also use the New Category button on the toolbar, or right click and select New then Category from the popup menu. Enter a name for the category. 
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After creating a new category, you can enter the category details on the Inventory tab. To preview the category in your web browser, click the Preview button. For more information about the fields on the Inventory tab, see the Interface section of the manual. 


Moving existing components into categories
You can add existing products and shelves to a category by dragging the product or shelf on to the category in the store tree. 
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Adding new components to the category
You can add components to the category by highlighting the category in the Store Tree and adding new components to it with the toolbar or button bar. This option will not be enabled if a category cannot be added to the section of the Store Tree that you have highlighted. You cannot add an image to a category using the Inventory tab. You must place the image into the description section of the Inventory tab using HTML. 

Note: You can use a category with no items beneath it to add an informational page (without products) to the store. 
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Adding a List 




A product list allows you to place more than one product into a price list on a single page in the store. This is good for cross selling or listing related products on a single page. (It can also be used to create a list of product discounts if buying large numbers of items will result in the buyer obtaining a cheaper price). Below is a sample list. 
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To create a list, select the section of the store that you wish to add the list to from the store tree. Then click the List button. You can also use the New List button on the toolbar, or right click and select New then List from the popup menu. Enter a name for the list. The contents of the list will be displayed in the product pane. 
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After creating a new list, you can enter the list details on the Inventory tab.To preview the list in your web browser, click the Preview button. For more information about the fields on the Inventory tab, see the Interface section of the manual. 


Adding existing products to the list
You can add existing products from anywhere in the store to the list by copying the product and pasting it into the list. You can also add existing products by creating products in the list with the same product number as those in the other parts of the store. 
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Adding a web page 




You can add a web page with information and no items to your store. 
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To add a web page, select the section of the store that you wish to add the page to from the store tree. Then click the Page button. You can also use the New Page button on the toolbar, or right click and select New then Page from the popup menu. 
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Enter a name for the page. Simply enter the information in HTML format in the description field. When you generate the store, you will get a page with no products, just the text and html entered. You can move the page by dragging into any section of the store. To preview the web page in your web browser, click the Preview button. 
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Adding company information 




You will need to add information to the Contact Us, News and About Us web pages. Click the on web page on the Store Tree and enter information on the Inventory Tab. To rename the page enter a different value in the title and page title fields. Enter the information in HTML format in the description field. To preview the web page in your web browser, click the Preview button. 

You also need to customize the main page of your store. Click on the folder item with your store name on the Store Tree and enter information into the Inventory tab. 
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Adding a link 




You can add links to the naviagation menu of your store. 
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To add a link, select the section of the store that you wish to add the link to from the store tree. Then click the Link button. You can also use the New Link button on the toolbar, or right click and select New then Link from the popup menu. 

[image: image52.png]£ eComm PRO - Sample Internet Cake Shop
Eio Bk Yow Qotins tib

1= (2 Sample Intemet Cake Shop.

23 Sweets.
G Cokes
o B ueenn

oy b

B Sorene

B o

g i

olalg| oy =lglEolEel 8 @

Prvien

Product
Cotegay
E

£

g

¢ [






Enter the URL and title for the URL on the Inventory tab. When you generate the store, you will get a link in the navigation menu on the left hand side of the store. To preview the link URL in your web browser, click the Preview button. To toggle display of bullets on the navigation links, edit the Store Options. 
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Building the store 




Building the store generates all HTML files required by the store, including the shopping cart. You can build the store at any time to get a working preview of the store. To build the store, click the Build button. This will open the build window. Here you can change the build directory if desired, and you can specifiy to build only a selected part of the store. 
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Click the Build button to start the build process. Any errors encountered during the build of the store will be displayed in the Build window. You should check to see if any errors appear and ensure that if they do, they do not interfere with the operation of the store. Once the build is completed, the store will be opened in a browser window. 
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Publishing the store 




After building your store, you will need to publish the store to the Internet. Before publishing your store you will need to set up an order server account. See the Order Server section of the manual for more information. Ensure that your ftp and hosting details are entered in Preferences . When you are ready to publish your store, click the Build button to open the Build window. Build the store to ensure that the files are up to date. 

Click the Publish button to open the Publish window. If you are uploading the store for the first time, all the files will need to be uploaded. Click the Connect button to connect to your ftp server. Once connected, click the Compare button to check which files need to be uploaded. eComm will check which files have been changed since the last upload, and mark them accordingly. Files that need to be uploaded have a red clock icon. Files that are current have a green tick icon. 
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Click the Upload button to start the file transfer. The ftp commands are shown at the bottom of the window. When the files have been uploaded, they will be marked with a green tick. 
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Click the Disconnect button to close the connection to your ftp server. Your store is now on the Internet. To access your store, enter the URL in a web browser. 
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Testing 



After uploading the store, you should test the store to ensure it is functioning correctly. 

Some items to check are: 

· The navigation links 

· Products and items 

· Images for products 

· Description text 

· HTML errors in descriptions, the order form and the confirmation message 

· Taxation 

· Color schemes 

· Ordering process (see the Downloading orders section of the manual) 

· The Payment Gateway charging process 
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Working with Projects 




The chapter explains how to work with projects 

[image: image61.png]23 eComm PRO - Trellian Software.

Mo 5608 05 33|

o EE

= —
ke L tept

Simtrarma

s 2 o e





[image: image62.png]@ eCommStore

&5




Saving a Project 




You can force eComm to save changes to your project by selecting the Save option from the File menu. Projects can also be saved under a different name by using the Save As option instead. 
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Restoring from backup 




If you want to revert to a previously saved version of the store, you can restore from backup. Select Restore from Backup from the File menu to open the restore window. 

[image: image65.png]&3 Restore project from Backup

T 093314
eIz 5T
WM 7D
W RE R
ez 6
WA EDN  aEs
WS TTRY s
s 97
WRMITIEN
WM s






The restore window lists the dates, times and the sizes of the store when it was saved previously. Select the backup to restore and click the OK button. 
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A confimation message is shown. Click Yes to restore the store or Cancel to abort the restore process. The selected store will then be restored. 
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Merging projects 



Merging copies the products and items from another store into the store that is currently open. To merge projects, open the store that you wish to merge into. Select Merge from the File menu to select a store to merge products and items from. 
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Select a project to merge from and click the Open button. 

The store will now contain the products and items from the merged store. 
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Importing a database 




Importing a database allows multiple products to be imported or updated in eComm at one time. Most databases and spread sheet programs have an "export database to delimited file" function. This file is use by eComm. 

To import product data, select the shelf or category to import the products into. Select Import from the File menu. Locate the file you wish to import from and click the OK button. 
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Field Delimiter
Any character can be used to separate the fields in the text file. Commas are the standard character used by most applications and are default in eComm Store/PRO. The delimiter character can be changed by entering the appropriate character in the Field Delimiter field. 

Quote Character
The Quote characters is the character used to signify the start and end of a string if the delimiting character is used in a sentence. The example above uses the colon : character as the delimiter. This sentence uses the colon character. 

SubmitWolf PRO is an easy to use, professional website promotional tool, which automates the process of promoting your web pages on the Internet. Languages available: French, German, Dutch, Japanese, Italian. 

To use this string as one field in eComm, use the quote character, which is ".

"SubmitWolf PRO is an easy to use, professional website promotional tool, which automates the process of promoting your web pages on the Internet. Languages available: French, German, Dutch, Japanese, Italian. "

eComm ignores the colon in the middle of the string and includes the whole string as the one field to import. The quote character can be changed by entering the appropriate character in the Quote Character field. 

Quote Escape Character
This field defines the character used to represent the closing quote character. Usually this is the same as the Quote Character. The quote escape character can be changed by entering the appropriate character in the Quote Escape Character field. 

Decimal Point
This field defines the character used to represent a decimal point. The decimal point character can be changed by entering the appropriate character in the Decimal Point field. 

Columns data fields
To give the column headings a field name, right click the column heading and select a value from the menu. 
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To import the product list, select the products to import by holding down the control key and clicking the products you wish to import. 
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When all required products are selected, click the Import button to import the data into the current category or shelf in eComm. 

Updating Data
To update existing eComm product data select the shelf or category where the products requiring updating are located. Select Import from the File menu. Locate the file you wish to import from and click the OK button. Select the products to update and click the Update button. If the products being updated have the same Product Code as an item already in the eComm database, the data for each item with a matching Product Code will be updated. 
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Tax 




This chapter explains how to set up taxation 
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Region Based Tax 




Region Based Taxation means that you will be able to set a different tax rate for each different region that you ship to. If you did not specify region based taxation in the setup wizard, you can access the tax wizard by selecting Tax Options from the Options menu and clicking the Edit button. Follow these instructions to set up Region Based Taxation. 

You can navigate forward and back through the wizard using the Next and Back buttons at the bottom of the wizard. You can start the interactive help option at any time by pressing the Help button on each page of the wizard. 

Select Region Based Taxation. Click Next to continue. 
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Enter the tax rate for each region. To enter a tax rate highlight the name of the region and enter the tax rate in the "Tax Rate" field. If you do not want to charge tax in a particular region, do not assign a tax rate to it. Click Next to continue. 
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Enter the tax rate that will applied to your shipping charges. This can be used to set the tax rate on the shipping component of the customer's order. Click Next to continue. 
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You have finished setting up Region Based Taxation. The tax rate for each product can be entered in the tax field on the Inventory tab. 
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Product Based Tax 




Product Based Taxation means that you will be able to set a different tax rate for each item in your store. All regions will be taxed at the same rate using this method. If you did not specify product based taxation in the setup wizard, you can access the tax wizard by selecting Tax Options from the Options menu and clicking the Edit button. Follow these instructions to set up Product Based Taxation. 

You can navigate forward and back through the wizard using the Next and Back buttons at the bottom of the wizard. You can start the interactive help option at any time by pressing the Help button on each page of the wizard. 

Select Product Based Taxation. Click Next to continue. 
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Select the regions that are taxable by highlighting the name of the region you want to tax and ticking the "Taxable" checkbox.Click Next to continue. 
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Enter the tax rate that will applied to your shipping charges. This can be used to set the tax rate on the shipping component of the customer's order. Click Next to continue. 
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You have finished setting up Product Based Taxation. The tax rate for each product can be entered in the tax field on the Inventory tab. 
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Special Tax Cases 




Some users may have special tax requirements for specific states or regions. The following is an example of setting up a state based tax of 15% and a 10% tax for all other regions. 

Click the Wizard button on the freight tab.
Enter the desired delivery methods and click Next to continue. 
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Add the regions that require seperate taxation, and click Next. 
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Select the method by which the delivery charges will be calculated and click Next
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Now the tax options need to be specified. Select Tax Options from the Options menu. Click the Edit button. 
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Select Tax Enabled Shopping Cart. Click Next to continue. 
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Select Region Based Taxation. Click Next to continue. 
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Enter the tax rate for each region.Click Next to continue. 
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Enter the tax rate that will applied to your shipping charges (if applicable). This can be used to set the tax rate on the shipping component of the customer's order. Click Next to continue. 
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Click OK to complete the process. 
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Store Orders 




This chapter explains how to retrieve and process orders 
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Setting up an account 




Before setting up an order server account, your installation of eComm must be registered. See the Registration section of the manual.

To create a new order server account enter the following URL in your browser:http://ecomm.vendercom.com. 
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Click the "Create new account" link. 
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Enter your eComm serial number, create a password and enter your email address. Click the Continue button. 
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If you have registered eComm PRO, the order server account will be free. For eComm Store users, the fee is $15 US per month. Read the Vendercom agreement and then scroll down and enter your contact details. Click the Create Account button to create your account. In eComm, click Options, Preferences and click on Order Server to see your username. 
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Payment Gateway Account 




A payment gateway account is used to process credit card orders. 
The payment gateway providers for Australia are:

Ematters http://www.ematters.com.au/

Eway http://www.eway.com.au/


The payment gateway providers for the USA are:

Authorize.net http://www.merchantwholesalers.com/trellian/
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Downloading Orders 




To download orders select Orders from the View menu. This will display the order manager window. If you want to leave a copy of the orders on the server, ensure that you have selected this option in Preferences. Select Download Orders from the File menu or click the Download button. Enter your username and password when prompted. If you have forgotten your password click on the following URL or enter the URL into your web browser: https://ecomm.vendercom.com and click the lost password link. 
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The new orders have a yellow pending status image. After the order has been clicked on, the status changes to the normal pending image. To view the order details, click on an order in the top window pane. The order details will be shown in the pane below. 
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Processing Orders 



After downloading the orders, you need to process the orders. The new orders have a yellow pending status image. After the order has been clicked on, the status changes to the normal pending image. 
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Click on an order to view the product ordered and the payment details.

Order status
Each order has a status icon. When the orders are downloaded, they all have the status of pending. After an order has been processed, the status can be changed to one of the following: 

	Image:
	Description:
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	The order is new

	[image: image108.png]



	The order is pending
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	The order payment has been charged
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	The order payment has been rejected
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	The order has been dispatched
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	The order requires confirmation
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	The order is on backorder
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	The order payment has been charged back (refunded)




As each order is processed, the status of the order can be set by selecting a radio button corresponding to the status. 


Charging an order
Ensure you have set up a Payment Gateway account in Preferences before charging an order. Select the order you wish to charge by clicking on the order. Click the Charge button to connect to the Payment Gateway service. 
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Preferences 




This chapter explains how to set the eComm preferences 
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Settings 
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HTML browser
Enter the path to your web browser. eComm will use this browser to open web pages within the program. 

Open in Existing Browser Window
Select this option to open each new web page in the existing window 

Open in New Browser Window
Select this option to open each new web page in a new browser window 
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Store Options 
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Build Options

3D shopping cart
Adds a 3D effect to your shopping cart 

Use bullets
Places an icon before each item on the navigation menu of your store 

Shopping Cart always on Screen
Select this option to display the shopping cart. Otherwise the shopping cart is hidden from the user until an item is added to the shopping cart. 

Translate CR/LF to HTML Breaks
This option will make the program add a carriage return in the description field each time enter is pressed. If you do not have this option set, a HTML <BR> is required to add a carriage return. 

Product Search
Places a search box on the store to allow users to search for products 



Store Navigation Style

Classic
Displays 2 levels of navigation links 

Browse History
Displays 1 level of navigation links 



Shopping Directory

Participate in the eComm Store/PRO traffic exchange program and add your site to the Vendercom shopping directory
The eComm shopping directory is a collection of links to online shop fronts built using Trellian's eComm products, there is a wide variety of different goods on offer with store listing being frequently updated.
Not only is it useful resource for the shopper, it is a simple and effective way to get exposure for your online shop front. Reciprocal links are regarded as crucial for getting a site noticed and improving search engine rankings, the higher the traffic at these linked sites the better it is for all involved. 
The eComm shopping directory consistently gets high levels of traffic, this is one of the best link exchanges you could ever make to increase your shop front's exposure .
Listing in the directory is free to any online shop front that has been built in one of Trellian's eCommerce tools and is displaying the "other stores" link.


The eComm Store/PRO Vendercom eCommerce directory is located at http://www.vendercom.com/directory.htm.

To add your store to the directory, tick the Participate in the eComm Store/PRO traffic exchange program and add your site to the Vendercom shopping directory checkbox and fill in this form http://www.vendercom.com/addurl.htm
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Proxy Settings 
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Proxy
If you need to use a Proxy Server to connect to the internet, you should specify the address of the proxy in this field. If you find that you are getting constant 'Host not Found' messages, you should check and make sure that both the address and the port of your proxy are correct 

Port
Specifies the port to use if using a Proxy 

Username
Specifies the username to use when accessing the Proxy. (Not required on all proxy servers, please ask your System Administrator for help if unsure) 

Password
Specifies the password to use when accessing the Proxy. (Not required on all proxy servers, please ask your System Administrator for help if unsure) 
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Firewall Settings 
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Server
If you need to use a firewall to connect to the internet, you should specify the address of the firewall. If you find that you are getting constant 'Host not Found' messages, you should check and make sure that both the address and the port of your firewall are correct. 

Port
Specifies the port to use if using a firewall 

Username
Allows you to specify the username for authenticating firewalls 

Password
Allows you to specify the password for authenticating firewalls 
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Sounds 
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The Sound settings allow the customization of sounds that can be triggered by the program in response to certain events or actions. To use this feature you simply select the event from the list provided. You can then assign a different Wave File (*.wav) to any event in this list. 

Browse
Allows you to browse your hard drive for sound files that you may assign to certain program events 

Play
This function allows for the preview and playback of all sound files you select 

Event/Sound
Provides a list of program events and all of the sounds assigned to that particular event 

OK
Assigns the sounds to the events you have selected 

Note: eComm currently supports only standard Microsoft Windows Wave (.wav) files. 
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Order Server 
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The Order Server section allows you to select which order server to use for storing your online orders. 

Server URL
Specifies the URL of the order server 

Username
Specifies the username to use on the online order server 

Leave Orders on Server
If ticked, orders will not be erased from the server after being downloaded to the Order Manager 

Next Order Number
Specifies the number of the next order. Allows you to reset the order numbers according to your numbering scheme 
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Payment Gateway 
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The Payment Gateway section allows you to select which payment gateway to use for processing online orders. Each service provider requires different authentication details. 

Service
Select the service provider from the dropdown list 
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Merchant Details 
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The Merchant Details section is used to specify information about your store such as Company name, and contact details. 

This information will appear on Invoices and order confirmations. 
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Hosting 
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The Hosting section is used to specify information about your account on your hosting provider, so eComm can publish your website. 

FTP Server
Enter the ftp server host address, provided by your hosting provider 

Port
The port number to use. Usually this is 21 

Username
Enter your username as provided by your hosting provider 

Password
Enter your password as provided by your hosting provider 

Save Password
If ticked, eComm will remember your password so you won't have to enter it every time you upload your store 

Remote Directory
If your hosting provider has given you a folder to use on the remote host, enter that folder name in this field 

Passive Transfer
Some firewalls require this, if you are unsure, consult your system administrator 

Server Timeout
The timeout value determines how long eComm will wait when connecting to the ftp server 

Subscribe
If you haven't got an account with a hosting provider, then click the Subscribe to subscribe to Vendercom Hosting. 
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Interface 




The main interface of eComm contains all of the most commonly used functions available to the user and is packed with features. 
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This is the main screen of eComm. 

Product/Category Tree
The upper left hand side contains a tree structure that represents your store. 

Product/Category List
The lower left hand side contains a list of the items in the structure below the selected point. 

Tabs
The tabs on the right hand side allow the user to enter information about products, shipping or website settings. 
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The Toolbar
The buttons on the toolbar provide a quick shortcut to commonly used functions. The toolbar can be toggled on or off by selecting the Toolbar option from the View menu. The toolbar button functions are as follows:

	Image
	Name
	Description

	[image: image140.png]



	New Store
	Launches the new store wizard and creates a new store.

	[image: image141.png]=]




	Open Store
	Opens an existing store
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	Save Store
	Saves changes to the store. This button will only be enabled if changes have been made since the last save. To undo a save, use the Restore from backup option from the File menu to restore a previously saved version of your store. 
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	Help
	Enables interactive help. You can turn help off at any time by clicking the X at the top right corner of the Help Window. 
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	View Orders
	Opens the order window so you can download and process orders. 
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	New Product
	Creates a new product in the store at the selected point of the store tree. This button will not be enabled if a product cannot be added to the currently selected point of the store tree. 
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	New Shelf
	Creates a new shelf in the the store at the selected point of the store tree. This button will not be enabled if a shelf cannot be added to the currently selected point of the store tree.
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	New List
	Creates a new list in the the store at the selected point of the store tree. This button will not be enabled if a list cannot be added to the currently selected point of the store tree
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	New Category
	Creates a new category in the the store at the selected point of the store tree. This button will not be enabled if a category cannot be added to the currently selected point of the store tree
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	New Link
	Creates a new link in the the store at the selected point of the store tree. This button will not be enabled if a link cannot be added to the currently selected point of the store tree
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	Build Store
	Opens the build store window allowing you to generate the HTML for the store and preview a fully functional store. After building the store, it will be opened in a browser window. The store can be built at any time to generate a preview
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	Preview Page
	Previews the currently selected item in a browser window. This is a layout preview only and links will not function. To preview a functioning store, use the Build button.




Buttons
The buttons provide a quick shortcut to commonly used functions. The buttons can be toggled on or off by selecting the Buttons option from the View menu. The button functions are as follows:
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	Button
	Description

	Preview
	Previews the currently selected item in a browser window. This is a layout preview only and links will not function. To preview a functioning store, use the Build button. 

	Product
	Creates a new product in the store at the selected point of the store tree. This button will not be enabled if a product cannot be added to the currently selected point of the store tree. 

	Category
	Creates a new category in the the store at the selected point of the store tree. This button will not be enabled if a category cannot be added to the currently selected point of the store tree 

	Shelf
	Creates a new shelf in the the store at the selected point of the store tree. This button will not be enabled if a shelf cannot be added to the currently selected point of the store tree. 

	List
	Creates a new list in the the store at the selected point of the store tree. This button will not be enabled if a list cannot be added to the currently selected point of the store tree 

	Page
	Creates a new page in the the store at the selected point of the store tree. This button will not be enabled if a page cannot be added to the currently selected point of the store tree 

	Link
	Creates a new link in the the store at the selected point of the store tree. This button will not be enabled if a link cannot be added to the currently selected point of the store tree 

	Build
	Opens the build store window allowing you to generate the HTML for the store and preview a fully functional store. After building the store, it will be opened in a browser window. The store can be built at any time to generate a preview 
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The Inventory Tab 




This section deals specifically with the component details. 
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The Inventory tab allows you to enter component details into the store. This information is used to generate the pages of your store and to work out shipping costs. 

Not all fields on the Inventory tab will be visible to the user. The way the components are dispayed on the web page can be changed in the Layout Tab, however the default layout is as below: 

[image: image155.png]labell valel
label2 vae?
label3 a3

IMAGE ~ lhevaet

Descrpion ofthe





The fields in the Inventory tab are: 

	Field:
	Description:

	Product Code
	Each product must have a unique code. The code is required by the shopping cart software, and may be arbitrary. The code does not appear on the web page. The product code will be displayed on itemized invoices and orders. This field is substituted for the $CODE variable in the layout template. 

	Title
	The title of a category, or product, as it will appear in your store's navigation tree. For best results, use a short, descriptive name. The full title can be entered in the 'Page Title' field below.

	Page Title
	A full descriptive title of the component. The title will become the heading of the page as shown in the image above. In the layout template file, this field is substituted for the $PAGETITLE variable. Note: If left blank, the Category/Product Title field above becomes the page title.

	Filename
	The name of the HTML file that will correspond to the current category or product. When eComm creates your store, each component becomes a separate HTML file eg: http://www.mystore.com/filename.htm where filename.htm is specified in this field. In the layout template, this field is substituted for the $FILENAME variable.

	Template
	Each category and product, has an associated layout template. This is a HTML file with embedded substitution $VARIABLES, that determines the overall appearance of each store page. For information on how to change the template, see the Template Tab section of the manual. 

	Meta Description
	A brief description of the category or product. From the description, eComm will generate a description META tag. This tag is used by search engines when indexing your web site. Tip: Keep the description brief, with the most important information in the first few lines. This field is substituted for the $META_DESCRIPTION variable in the layout template.

	Meta Keywords
	A comma separated list of keywords or phrases, that best describe the category or product. eComm will generate a META tag from these keywords. META tags are used by search engines to index web pages. Tip: The most relevant keywords should always come first. This field is substituted for the $META_KEYWORDS variable in the layout template.

	Color
	The color of your product.This field can be changed to accept any other values. eg. Material type, flavor, length, etc

	Size
	The size of your product.This field can be changed to accept any other values. eg. Material type, flavor, length, etc.

	Image
	The URL (or filename) of a thumbnail image for the current product or category. This field is substituted for the $IMAGE variable in the layout template. Note: Local image files are copied to the ../images directory during build. 

	Links To
	The destination URL or filename. Clicking on a thumbnail image (defined in the above field), will open the specified destination URL or file. Usually this will be a larger picture of the product or category. The link can be a web page, or a link to another image file. This field is substituted for the $LINK variable in the layout template. Note: Local image files are copied to the ../images directory during build. 

	Cost
	The unit sale price of the product. Note: Currency symbols are ignored, and must be entered in the template file. This field is substituted for the $COST variable in the layout template 

	Weight
	The weight of a product. The freight calculation is based on the total weight of an order. Note: The weight can be in any unit of measurement, provided the same units are also used in the freight tables. This field is substituted for the $WEIGHT variable in the layout template. 

	Freight
	Some products may incur additional freight charges, either due to insurance, or special packaging requirements. Such products can have an associated freight surcharge. The surcharge is added on top of the final freight cost. This field is substituted for the $FREIGHT variable in the layout template. 

	Tax
	The % of tax applied to this item. 

	Description
	A description of the component. The description appears as shown in the above image. 

	Label
	Each of the six custom fields can have a Label. The labels can be in plain text, or use HTML. These fields are substituted for the $LABEL1, $LABEL2, $LABEL3, $LABEL4, $LABEL5 and $LABEL6 variables in the layout template. A typical use for the label fields is to hold information such a the manufacturer name, dimensions, weight etc. eg. The label field may be used to display the label "Manufacturer Name" and the manufacturer name entered in the corresponding value field (see below). They appear on the web page as shown in the above image. 

	Value
	The value fields can have any value, including HTML. These fields are substituted for the $FIELD1, $FIELD2, $FIELD3, $FIELD4, $FIELD5 and $FIELD6 variables in the layout template. 
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The Freight Tab 




This section deals specifically with the component freight details. 
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The freight tab allows you to enter component freight details into the store. To change the freight details and countries that the store ships to, click the Wizard button. For information about the freight wizard, see the New Project section of the manual. 

Changing Freight Details
To change the freight companies or methods, click the Methods button. You can then enter the desired freight details. 

Entering Freight Details
For each country, you must either fill in the freight table to ship a package of 0.5 to 10 units of weight, or enter a set of advanced freight calculation rules. Click on a country name in the list to enter the shipping costs for the country. Enter the cost to deliver an item of less then 0.5, 1.0, 2.0 .... 10.0 units of weight to the country.The 11+ field should contain the cost to ship each additional unit of weight above 10. 
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Advanced Freight Rules
To add advanced freight rules, select the method type, then select a country or region from the drop down list. 
Freight rules consist of 2 values and a comparison. A comparison B, where A is the dollar amount to be added to the freight and B is the weight of the order. The comparison operaters are: 

	Comparison Operator:
	Description:

	<
	Less than

	<=
	Less than or equal to

	>
	Greater than

	>=
	Greater than or equal to

	!= or <>
	Not equal to




Note: There is no = (equals) operator

Example:
2.95<=1k 

The freight costs $2.95 for 1k or less of weight. 



More than one rule may be used for each country. Seperate rules by commas. 

Example:
1.95<=0.5k,5<=1k 

If the weight is under 0.5k, the cost is $1.95.
Else if the weight is under 1k, the cost is $5 

-1 means that freight is not available. 

Example:
1<=1k,2<=2k,-1>2k 

$1 for 1k of weight, $2 for 2k of weight and no other weights are accepted to this destination. 
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The Template Tab 




This section deals specifically with the Template Tab. 
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Each category and product, has an associated layout template. This is a HTML file with embedded substitution $VARIABLES, that determines the overall appearance of each store page.To edit a template, select the template you wish to change and edit the HTML code in the lower window. The variable names begin with $. The value of the variables are shown in the Variables tab. The variables names from the Inventory Tab are shown in the following table: 

Variable Description


	Variable:
	Description:

	Product Code
	$CODE

	Page title
	$PAGETITLE

	Filename
	$FILENAME

	Meta Description
	$META_DESCRIPTION

	Meta Keywords
	$META_KEYWORDS 

	Meta Title
	$META_TITLE 

	Image
	$IMAGE 

	Tax
	$TAX 

	Link To
	$LINK 

	Cost
	$COST 

	Weight
	$WEIGHT 

	Freight (only if cost per order shipping is implemented)
	$FREIGHT 

	Label
	$LABEL1, $LABEL2 etc 

	Value
	$FIELD1, $FIELD2 etc 

	Category Product Index
	%CategoryList%

	Category Product Index (2 columns)
	%CategoryList2%

	Embed HTML filename
	%FILE=filename%

	Cost of one item (order form template only)
	%UNITPRICE%

	Cost of all the items (order form template only)
	%PRICE%

	Used to build a page containing the items from product number x
	<PRODUCTX&GT; ....</PRODUCTX&GT;




Button Description


	Button:
	Description:

	Import
	Imports a HTML template file

	View
	Opens the currently selected template in a web browser for viewing

	New
	Creates a new template

	Default
	Sets the currently selected template back to the default settings
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The Order Form Tab 




This section deals specifically with the Order Form Tab. 
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Changing the currency symbol
To change the currency symbol, delete the current symbol from the Currency Symbol field, and type the new currency symbol. 


Changing the order form comment
Delete or modify the text in the Order Form Comment field. You can enter HTML tags in this field. 


Changing the accepted credit cards
To add or remove credit cards, right click in the Accepted Cards window. Click the Add/Remove Credit Cards menu option. 
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Credit Cards can then be added or removed from the list. 
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Changing the order form template
The order form has an associated layout template. This is a HTML file with embedded substitution $VARIABLES, that determines the overall appearance of the order form web page.To edit the order form template, edit the HTML code in the HTML Order Form Template window. The variable names begin with $. The value of the variables are shown in the Variables tab. The variables names from the Inventory Tab are shown in the following table: 

Variable Description


	Variable:
	Description:

	Product Code
	$CODE

	Page title
	$PAGETITLE

	Filename
	$FILENAME

	Meta Description
	$META_DESCRIPTION

	Meta Keywords
	$META_KEYWORDS 

	Image
	$IMAGE 

	Link To
	$LINK 

	Cost
	$COST 

	Weight
	$WEIGHT 

	Freight (only if cost per order shipping is implemented)
	$FREIGHT 

	Label
	$LABEL1, $LABEL2 etc 

	Value
	$FIELD1, $FIELD2 etc 

	Category Product Index
	%CategoryList%

	Category Product Index (2 columns)
	%CategoryList2%

	Embed HTML filename
	%FILE=filename%

	Cost of one item (order form template only)
	%UNITPRICE%

	Cost of all the items (order form template only)
	%PRICE%

	Used to build a page containing the items from product number x
	<PRODUCTX&GT; ....</PRODUCTX&GT;




Button Description


	Button:
	Description:

	Default
	Sets the template back to the default settings

	Load
	Loads a HTML file to replace the order form

	View
	Opens the template in a web browser for viewing
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The Confirmation Tab 




This section deals specifically with the Confirmation Tab. 
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Changing the order confirmation message
Delete or modify the text in the Confirmation Message field. You can enter HTML tags in this field. 


Changing the confirmation web page template
The confirmation web page has an associated layout template. This is a HTML file with embedded substitution $VARIABLES, that determines the overall appearance of the order form web page.To edit the confirmation web page template, edit the HTML code in the HTML template window. The variable names begin with $. The $CONFIRM variable is the confirmation messge.
For Example:
Total charged = $Total 
$NAME
$ADDRESS
$CITY
$STATE $ZIP
$COUNTRY


Would display the total charged and the customer's details. 



	Button:
	Description:

	Default
	Sets the template back to the default settings

	Load
	Loads a HTML file to replace the confirmation form

	View
	Opens the currently selected template in a web browser for viewing
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The Layout Tab 




This section deals specifically with the Layout Tab. 
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The layout tab is used to define the aesthetics of your store. You can define the colors and graphics used by the program when building your store. Right click within the schemes list for additional options. 

Changing the style and color scheme
Select a style and color scheme and click the View button to see your project in the new style and color scheme. If you wish to use the selected style and color scheme, click the Apply button. 

Editing the schemes
To create your own color scheme, select the style you wish to change. Click the New button to create a new color scheme. 

[image: image169.png]Select Schema
+ Green
Bl

+ Diange

Preview:

Edt
X Delete.

Preview





Right click on the New Schema and select Rename from the popup menu to give your color scheme a name. Click the Edit button to edit the colors used by the style. You can change the images used by the style, and add new variables to the scheme. To change colors, click on the color sample box and select another color from the color palette. 
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Main Page
	Item:
	Description:
	Value:

	Background color
	The background color of the main product/category page. This field is substituted for the %BGCOLOR% variable. 
	HTML color name or color code

	Text color
	The color of text on the main product/category page. This field is substituted for the %TEXTCOLOR% variable.
	HTML color name or color code

	Link Color
	The color of hypertext links on the main product/category page. This field is substituted for the %LINKCOLOR% variable.
	HTML color name or color code

	Visited Link Color
	The color of visited hypertext links on the main product/category page. This field is substituted for the %VLINKCOLOR% variable.
	HTML color name or color code

	Active Link Color
	The color of an active link on the main product/category page. This field is substituted for the %ALINKCOLOR% variable.
	HTML color name or color code

	List Color
	The background color of the Store Navigation Tree. This field is substituted for the %MENUCOLOR% variable.
	HTML color name or color code

	Heading
	Navigation Tree Title HTML code, which will form a title at the top of the Store Navigation Tree. Click on the [>>] button to edit the field. This field is substituted for the %HEADING% variable. 
	HTML code and text

	Title Color
	The color of the page title. This field is substituted for the %TITLECOLOR% variable.
	HTML color name or color code

	Logo
	The logo to use on the main page. This field is substituted for the %LOGO% variable. An image size of 148x88 pixels works best. 
	A GIF, JPEG, or PNG file.




Shopping Cart
	Item:
	Description:
	Value:

	Background color
	The background color of the shopping cart. The color sample box on the right shows the currently color. This field is substituted for the %S_BGCOLOR% variable. 
	HTML color name or color code

	Link Color
	The color of hypertext links on the shopping cart. This field is substituted for the %S_LINKCOLOR% variable.
	HTML color name or color code

	Visited Link Color
	The color of visited hypertext links on the shopping cart. This field is substituted for the %S_VLINKCOLOR% variable.
	HTML color name or color code

	Active Link Color
	The color of an active link on the shopping cart. This field is substituted for the %S_ALINKCOLOR% variable.
	HTML color name or color code

	List Color
	The background color of items list on the shopping cart. This field is substituted for the %S_LISTCOLOR% variable.
	HTML color name or color code

	Frame Color
	The color of the external border surrounding the shopping cart. This field is substituted for the %S_FRAMECOLOR% variable.
	HTML color name or color code

	Text color
	The color of text on the shopping cart. This field is substituted for the %S_TEXTCOLOR% variable.
	HTML color name or color code

	Cell color
	The color of cells on the shopping cart. This field is substituted for the %S_CELLCOLOR% variable.
	HTML color name or color code

	Background Image
	The image to use as the background on the shopping cart. This field is substituted for the %S_BACKGROUND% variable.
	A GIF,JPEG or PNGv file

	Heading color
	The color of the heading on the shopping cart. This field is substituted for the %S_HEADINGCOLOR% variable.
	HTML color name or color code

	Border Width
	The width of the border on the shopping cart. This field is substituted for the %S_CELLBORDER% variable.
	The number of pixels. eg 1,2,3 etc.

	Outside Border Width
	The width of the outside border on the shopping cart. This field is substituted for the %S_BORDER% variable.
	The number of pixels. eg 1,2,3 etc.

	Inside Border Width
	The width of the inside border on the shopping cart. This field is substituted for the %S_BORDER2% variable.
	The number of pixels. eg 1,2,3 etc.




Order Form
	Item:
	Description:
	Value:

	Background color
	The background color of the order form. This field is substituted for the %O_BGCOLOR% variable. 
	HTML color name or color code

	Text color
	The text color of the order form. This field is substituted for the %O_TEXTCOLOR% variable. 
	HTML color name or color code

	Link Color
	The color of hypertext links on the order form. This field is substituted for the %O_LINKCOLOR% variable.
	HTML color name or color code

	Visited Link Color
	The color of visited hypertext links on the order form. This field is substituted for the %O_VLINKCOLOR% variable.
	HTML color name or color code

	Active Link Color
	The color of an active link on the order form. This field is substituted for the %O_ALINKCOLOR% variable.
	HTML color name or color code

	Form Color
	The color of the form on the order form. This field is substituted for the %O_ALINKCOLOR% variable.
	HTML color name or color code

	Heading Background Color
	The background color for headings in the order form. This field is substituted for the %O_HEADINGCOLOR% variable.
	HTML color name or color code

	Heading Text Color
	The color of heading text in the order form. This field is substituted for the %O_HEADINGTEXTCOLOR% variable. 
	HTML color name or color code




Bullets
	Item:
	Description:
	Value:

	Bullet - Category
	The location/URL of an image icon that will represent a category in the Store Navigation List. This field is substituted for the %BULLET_F% variable. 
	A GIF, JPEG, or PNG file.

	Bullet - Product
	The location/URL of an image icon that will represent a product in the Store Navigation Tree.This field is substituted for the %BULLET_G% variable.
	A GIF, JPEG, or PNG file.

	Bullet - Current Item
	The location/URL of an image icon that will represent the currently opened category/product in the Store Navigation Tree. This field is substituted for the %BULLET_O% variable.
	A GIF, JPEG, or PNG file.

	Bullet - Back
	The location/URL of an image icon that will represent a link to a previous category in the Store Navigation Tree. This field is substituted for the %BULLET_A% variable.
	A GIF, JPEG, or PNG file.




Buttons
	Item:
	Description:
	Value:

	Button -Add
	The location/URL of a button/image, which when clicked, will add a product to the shopping cart. This field is substituted for the %BUTTON_ADD% variable. 
	A GIF, JPEG, or PNG file.

	Button -Back
	The location/URL of a button/image, which when clicked, will take the shopper to the previous product/category page. This field is substituted for %BUTTON_BACK% variable. 
	A GIF, JPEG, or PNG file.

	Button -Remove
	The location/URL of a button/image, which when clicked, will remove a product from the shopping cart. This field is substituted for %BUTTON_REMOVE% variable. 
	A GIF, JPEG, or PNG file.




NOTE: You may not be able to edit these items on all of the templates available. Some items have been hard coded to achieve a high quality look and feel of some of the templates. You can change the templates themselves, but the quality of the template may be compromised.


Deleting a schemes
To delete a scheme, highlight the scheme by clicking on it and press delete. A confirmation window will be displayed. 


	Button:
	Description:

	New
	Creates a new scheme for the selected style 

	Edit
	Edits the selected scheme 

	View
	Views the selected scheme in a browser window 

	Apply
	Applies the select style and scheme to the current project 
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The Variables Tab 




This section deals specifically with the Variables Tab. 
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The variables tab is used to define variables that can be used throughout your store. The format should be: $NAME Where NAME is the name you want to give the variable. Variables should be used for values or text that is placed throughout the store but is changed often. So that you can just change the value of the variable instead of finding each page that mentions the text and changing it. 

Changing variable values
Click on the variable you wish to change. The value of the variable is shown in the large panel. You can edit the value of the variable by deleting the current text and adding new text. 

Creating new variables
Click the New button to add a new variable. The variable name should begin with a $. You can edit the new variable's value by following the instructions above. 
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	File
	

	New Store
	Create a new store

	Open Store
	Opens an existing store

	Save 
	Saves changes to the store

	Save As
	Saves the store with a different file name

	Restore from backup
	Restores the current store from the backup

	Import
	Imports data from a comma delimited text file

	Merge
	Merges two shops together

	Upgrade
	Connects to the Trellian server then checks for Software Updates

	Work offline
	eComm works offline and does not attempt to connect to the Internet

	Quit
	Exits eComm
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	Edit
	

	Copy
	Copies the selected item or text to the Clipboard

	Paste
	Pastes the current data from the Clipboard

	Enable
	Toggles an item that is disabled (not visible in the store when built) to visable

	Disable
	Toggles an item that is enabled (visible in the store when built) to invisible

	Delete
	Deletes the current item or category

	New Category
	Creates a new category in the store

	New Product
	Creates a new product in the store

	New Shelf
	Creates a new shelf in the store

	New List
	Creates a new list in the store

	New Page
	Creates a new page in the store

	New Link
	Creates a new link in the store

	Insert
	Inserts an item into the store

	Find
	Allows you to search the currently selected text field

	Select All
	Highlights all items in the current section of the store
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	View
	

	Orders
	Displays the current orders from your store in a browser window

	Toolbar
	Toggles display of the toolbar

	Buttons
	Toggles display of the buttons on the main screen

	Default label fields
	Toggles display of the label fields in the Inventory tab
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	Options
	

	Preferences
	Allows you to change program settings

	Preview Page
	Previews the currently selected page in a browser window

	Build Store
	Generates the HTML pages for your store in the specified directory, then displays the index page in a browser window

	Add/Remove Credit Cards
	Allows you to add or remove credit cards accepted by your store

	Add/Remove Freight Regions
	Allows you to add or remove regions for tax purposes

	Tax Options
	Allows you to view and/or change the store tax options

	Import Freight Tables
	Imports freight tables from a different store
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	Help
	

	About
	Shows information about the program

	Help
	Displays popup help

	Register
	From here you can enter your license details to register the program

	FAQ
	Gives you a list of 'Frequently Asked Questions' to help you identify and solve common issues with eComm

	Manual
	Selecting this will open up the manual that you are currently reading

	Other Products
	Starts other Trellian programs




